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YourDyno Software user manual 
This user manual is an integral part of the YourDyno dynamometer controller system. 
This product and all its components are custom built devices designed for professional 
use, and to be used solely at research and development facilities for such purposes. 

 

©2024 Fonneland Engineering AS, all rights reserved. 

 

This manual is copyrighted by Fonneland Engineering AS, all rights are reserved. 
Original User Manual for YourDyno dynamometer controller software.  
 

This manual is furnished for informational use only, is subject to change without notice, 
and should not be construed as a commitment by YourDyno. 

 
YourDyno assumes no responsibility or liability for any error or inaccuracies that may 
appear in this manual. 
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2 Hardware setup 

  
Please refer to the relevant YourDyno hardware manuals on how to install the 
YourDyno hardware. 

3 Software installation 

 
To install the YourDyno software please download the latest installation package 
from www.yourdyno.com website. 

1. After downloading the installation package please execute the file 
"YourDynoinstaller_x.x.xx.exe". 

NOTE: x.x.xx stands for version number. 

Press the button "Next" to start the installation wizard. 

 

 

2. Please select the preferred plugins from the list. Do not install plugins you will not 
use, as they may consume CPU and memory resources.  
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Press button "Next" to continue. 

 

3. Select installation directory or keep default location. 
Press button "Next" to continue. 
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4. Press the "install" button to start installation. 
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5. After the installer has completed the job please press button "Finish" to close the 
wizard. 

 

4 What is the YourDyno software 
YourDyno is a highly customizable dynamometer control, data acquisition and data 
analysis software. The YourDyno Software allows users to perform manual or half-
automated test and measure various parameters of vehicles and engines. Additionally 
the YourDyno Software offers ability to expand functionality using the built-in plugin 
system. 

 
The YourDyno Software is under constant development and many new features are 
regularly being added. Please periodically review this manual and check for updates. 

5 Main window 
5.1 Overview 
The main window consists of four main sections: 
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1. Top menu bar: 

 

 

2. Graph area: 

 

 

3. List of recorded test Runs: 
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4. Status bar: 

 

6 Menu: File 
The following functions are available in this menu: 

Clear all runs - this function will remove all test runs from the Runs List below the 
graph area. 
Open runs - open previously recorded test. 
Save runs - save file with recorded test runs. 
Print page setup - opens dialog window with settings for graph print-out. 
Print... - opens printer dialog. 
Exit - close the software. 

6.1 Print page setup 
This function opens following setup window: 
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Use this window to adjust your print-out page. 

6.1.1 Customizing print-out header. Company logo 
1. To upload your logo please activate the check-box "Enable header image". 
2. Click on "Set header image" and use the following dialog window to navigate and 

upload your image file with logo. 
3. Use the "Swap text and image location" button to position the logo either on left or 

right side of the page. 
4. Adjust the "Header print height (mm)" to your liking. The higher the header the 

more room for text and logo. 
5. You may use the multi-line text box to enter your company name and contact 

details. 
6. Click and move left or right the vertical divider to adjust the width of the text box 

and logo area. 
7. To change page orientation (Portrait or Landscape) and adjust margins please press 

"Page setup..." button. 
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8. Use "Print preview" button to verify the settings. 



YourDyno Instrument kit 
Software user manual 

YourDyno.com 
Fonneland Engineering AS, 2024 

 

Page | 15 
 

 

7 Menu: Run 
7.1 New/Load Session 
Use this function to start a new testing session. A session may contain multiple test 
runs. You typically use a separate session for every new car or engine.  

 
A Session stores information about gear ratio, brake setup and auto start-stop settings 
for a set of test Runs. Please create a new directory for each session (Directory name = 
Session name). All test Runs recorded within one Session are stored in single .csv file 
on your hard drive under the directory you created. The raw .log files are also stored in 
the Session folder. 

To start a new session / load existing one please open this window: 
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Press the "New/Load Session" button to set the directory where you want to save your 
file containing test Runs. You can create a sub-folder structure to organize your 
customers database, for example: 

 

 
New Runs will be added to any existing Runs already open in main window.  

If the option “Enable correction for rolling resistance…” is on then whenever a new Run 
is started the software offers the option to use previously recorded Retardation data 
(friction losses) or record new Retardation data. It is recommended to always record 
new Retardation data if the transmission and other components allow it. If the 
retardation takes very long, you can add brake during retardation. 
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7.2 New Run 
Use this function to record a new test Run using the current Session. This function will 
directly open the Run (gauges) window.  Check all relevant settings prior to recording 
the Run. The recorded Run will be added to the list of Runs. 

8 Menu: Options 
8.1 Get the connections right first 
The YourDyno Standard and Ultimate have several RPM inputs, Load cell inputs and 
Outputs. There is a logic as to which is used for what.  

In general, RPM1 works together with Load Cell1 and Out1, RPM2 works together with 
Load Cell2 and Out2, etc. You cannot mix and match the numbers randomly. It gets a 
bit more complicated when there are linked brakes and when stepper motors are used, 
since each stepper uses 2 outputs. See the following table for correct assignment of 
channels:  
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8.2 Basic dyno Setup 
This function opens the main software settings window. 

 

Dyno type Number of load cells Load cell channel RPM Configuration Output brake channel(s)
Inertia dyno 0 None RPM1 = Load cell 1 RPM None
1 eddy brake 1 Load cell 1 RPM1 = Load cell 1 RPM Out1

2 eddy brakes 2
Load cell1
Load cell 2

RPM1 = Load cell 1 RPM
RPM2 = Load cell 2 RPM

Out1
Out2

2 eddy brakes with 1 RPM sensor 2
Load cell1
Load cell 2

RPM1 = Load cell 1+2 RPM or
RPM2 = Load cell 1+2 RPM

Out1
Out2

4 eddy brakes (2WD Hub w/2 brakes 
each) 4

Load cell1
Load cell 2
Load cell 3
Load cell 4

RPM1 = Load cell 1+2 RPM

RPM3 = Load cell 3+4 RPM

Out1
Out2
Out3
Out4

4 eddy brakes (4WD Hub) 4

Load cell1
Load cell 2
Load cell 3
Load cell 4

RPM1 = Load cell 1 RPM
RPM2 = Load cell 2 RPM
RPM3 = Load cell 3 RPM
RPM4 = Load cell 4 RPM

Out1
Out2
Out3
Out4

1 water brake 1 Load cell 1 RPM1 = Load cell 1 RPM Out1 + Out2
1 hydraulic brake 1 Load cell 1 RPM1 = Load cell 1 RPM Out1 + Out2

1 water brake w/2 valves 1 Load cell 1 RPM1 = Load cell 1 RPM
Out1 + Out2 (main valve)

Out3 + Out4 (secondary valve)

2 linked water brakes 2
Load cell 1
Load cell 2 RPM1 = Load cell 1+2 RPM

Out1 + Out2
Out3 + Out4
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8.3 Brake Dyno w/Load Cell(s) 
If your dynamometer is equipped with brakes (any type) activate the "This is a Brake 
Dyno with...." checkbox. Adjust the count of load cells in use using up and down arrows 
(1, 2 or 4 load cells).  

 

8.3.1 Inertia compensation 
The option "Compensate for inertia effects during acceleration" should normally always 
be on. This makes YourDyno calculate the power and torque used to accelerate the 
rotating components, which is an important component. Then enter correct value in 
the "Moment of Inertia..." filed in correct unit (kgm²). 

The inertia value needs to be entered under each load cell tab. The effective inertia is 
typically the same for each brake but does not need to be in case different brakes and 
or rollers are used on front and rear.  

 

 
The MOI entered in Options represents the dyno inertia (which is constant) and the 
MOI entered in the MOI Setup in the Run window represent the vehicle MOI (which 
varies from vehicle to vehicle). The numbers are added together. It is the total MOI that 
matters, so in practice it does not matter where the values are entered 

8.3.2 Load Cell calibration 
There are a few ways to calibrate the load cell. The recommended way is described 
below. 

8.3.2.1 Using a calibration arm 
Often large capacity load cells require the use of a long calibration arm to put enough 
weight on it. In the following, it is assumed that a calibration arm is used. The 
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procedure is the same if the weight is placed directly on top of the load cell, but this 
often will not give enough weight on the load cell.  

 

 

 

Calibration weight is the load you use to calibrate the load cell. The more accurate the 
value the more precise the wheel torque measurement will be. Aim for a combination 
of calibration weight and calibration arm length that produces of minimum 20% of the 
max rating of the load cell for accurate calibration.  

 

Distance to 
load cell 

Distance to calibration 
weight 

 

Aim for 20% or more when the 
calibration weight is on 
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8.3.2.2 Calibration procedure 
1. Make sure that the load cell is correctly installed in the dynamometer and that 

nothing obstructs the sensor nor the torque arm 
2. Make sure the Distance to calibration weight and Calibration weight are correctly 

entered 
3. Mount the calibration arm if used 
4. Press the "Zero calibrate!" button to set Load Cell zero. The numbers may still dance 

around, this is normal if the system has not been calibrated before 
5. Install the Calibration Weight either by hanging it from the calibration arm or 

placing it on top 
6. Press "Load calibrate". Verify that the Weight after calibration reads the calibration 

weight. Verify that the Raw load cell reading is > 20%. If not, it is recommended to 
use a larger calibrating weight 

7. Remove the calibration weight and calibration arm (if used) 
8. Press “Zero Calibrate” again 
9. Press "Save calibration" 

 
8.3.2.3 Calibration direction 
Use this setting to invert the calibration of the load cell. 
This is useful when you would like to run the dynamometer in opposite driving 
direction. 

 

 
Not all load cells are perfectly bi-directional and have exactly same calibration factors 
in both compression- and tension- directions. To assure highest possible measurement 
precision you should perform a "negative" calibration (use negative "Calibration 
weight" value). 

8.4 Inertia Dyno 
This section allows you to setup the Rotational Inertia for inertia-only dynos. 

To use the inertia-only dyno type please activate the checkbox "This is an Inertia Dyno" 
and enter the correct Mass Moment of Inertia in the field below.: 
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8.5 Engine power calculation for hub and roller dynos 

 
Roller and Hub dynamometers measure power and torque at the wheels. There is no 
physical possibility to measure actual Clutch or Crank power on roller and hub 
dynamometers. 

To be able to estimate the engine power, friction losses of the drivetrain must be 
measured during so called coast-down phase. To enable friction losses measurement 
please activate the "Enable correction for rolling resistance vs. speed from measured 
retardation data" checkbox.: 

 

 
WARNING: The brake is abruptly turned off when the end RPM is reached when this 
option is on. DO NOT TURN THIS OPTION ON FOR ENGINE DYNOS! 

Please note that the power losses in the drivetrain cannot be measured during coast-
down phase. The coast-down phase can measure solely coasting friction losses! 

Measuring friction losses gives a good estimation of Clutch (or Crank) power, but it is 
still burdened with a measurement error since the drive train will have higher losses at 
full power compared with at coast down. A roller dynamometer can therefore only 
measure parts of the losses, the total losses will be higher than the measured 
retardation losses. To accurately determine these losses, it is necessary to compare 
power readings between engine and roller dynamometer. 

To enable power-train losses correction, modify the "Power related losses" value: 
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There is no way to know exactly what the number shall be since the efficiency of the 
tires and drive trains vary. 5% can be a good starting point. 

8.6 Aux channels 
The YourDyno Ultimate controller offers 8 analog analog input channels (Aux 1 ... Aux 
8) and the YourDyno Standard has 3. 

 
All Aux channels can accept max. 5V DC. Connecting higher voltage to any of these 
inputs will damage the electronic circuit board and void warranty! 

To activate each channel, enable the checkbox. Click Configure to specify the analog 
input interpolation curve (relationship between input voltage and sensor reading). 
Sensor type and Unit are free text, and anything can be written here.  
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The relationship between voltage and signal can be defined in the curve, by either 
modifying points on the graph or editing it in a table. For the sensors that YourDyno 
sell, predefined curves are available using the Load ramp. 

8.7 Thermocouples 
The YourDyno Ultimate controller offers 8 Thermocouple Type-K inputs. The YourDyno 
Standard controller offers one. Select the number of thermocouples attached and 
rename them to your liking.  

 

8.8 RPM/Frequency channels 
YourDyno Ultimate has 6 digital channels and YourDyno Standard has 4. In addition, 
both have a dedicated Engine RPM inductive pickup channel.  
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The digital channels can be defined as Load Cell RPM, Frequency channel, Digital 
on/off, Flow meter and Other RPM.  

8.8.1 Load cell RPM channels 
First ensure each Load cell has an associated RPM channel. If a load cell does not have 
an RPM channel associated, it is ignored. For RPM channels, set number of pulses per 
revolution.  

Inertia dyno rollers use the Load Cell1 RPM (yes, this can be somewhat confusing).  

  
Ensure to write the correct number of pulses per revolution. This is the same as the 
number of teeth on the trigger wheel. Getting this number wrong will result in wrong 
results (even if RPM correct) 

Individual (unlinked) brakes need individual RPM sensors assigned. If two brakes share 
the same RPM sensor, then select LoadCell1+2 (for example) as the Function.  

8.8.2  Frequency channels 
This option is used to configure channels that measure the frequency of the input 
signal.  
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8.8.3 Digital On/off channels 
This option is used to configure channels that measure on/off signals like a zero 
position sensor of a water brake. A high (voltage > ca 2.5V) on the input = 1, otherwise 
it is 0. 

8.8.4 Flow meter channels 
Flow meters typically use a digital frequency based signal, meaning higher frequency = 
more flow. You need to know the number of pulses per volume to configure the 
channel. For example, a flow meter with 3000 pulses per gallon is configured like this. 
You can also define the time scale, hours, minutes, or seconds. The volume can be 
anything; liters, cubic feet, gallon, etc, as long as the pulses per volume match.  

 

8.9 Brake controller and other outputs  
YourDyno Ultimate has 4 outputs and Standard has 2. They can be used to control 
brake(s), throttle or other.  

Each Stepper motor/servo control uses 2 outputs, while Analog and Pulse Width 
Modulation (PWM) uses 1.  
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8.9.1  Brake controller setup 
The physical connection(s) to the brake(s) are setup here.  

Several predefined brake control outputs exist, as well as generic Analog 0-5V, PWM 
and Stepper options. See below. Select the one appropriate to your setup. 

 
8.9.1.1 Eddy brake power supply 
Choose the YourDyno Eddy brake power supply if your setup has this power supply. 
Set max voltage to the correct value. Optionally connect using Bluetooth to the PS to be 
able to read current and temperature. This is purely optional; the system works fine 
without.  

 
Make sure to know the max voltage rating of your brake. Large 16 coil brakes can be 
checked by measuring the resistance on the power terminals:  
16 coils 192V = ca 10 Ohm 
16 coils 96V = ca 2.5 Ohm 
It is recommended to wire the brake to 192V if possible (all coils in series). 
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You may use the "Test your brake" slider to manually set the brake output control 
signal and verify retarder operation. When powered up the Retarder is making 
characteristic "whining" noise. 

 
Note 1: This procedure will directly apply the output voltage regardless of current 
condition of your dynamometer 
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Note 2: The output only works if a brake (or something else like a light bulb) is 
connected. You cannot measure the output voltage if nothing is connected. 

WARNING: Potentially lethal voltages! 

8.9.1.2 Water brake valves 
Select the appropriate water brake type and under Configuration, select Use default 
stepper settings (unless good reason not to).  

 

See individual manuals for the valves for the detailed setup.  

8.9.1.3 PWM and Analog out 
If your brake controller uses Analog or PWM signal, then select that from the drop-
down list.  

 
Analog output requires to move a jumper inside the YourDyno box to the analog 
position 

8.9.2  Throttle output 
The throttle can be controlled by for example an RC servo. They typically use PWM. Use 
the configuration to set up the min and max positions and check that it works.  
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The throttle can be controlled by the Sequencer (a brake mode) or any other channel, 
also math channels and CAN bus channels.  

 

8.9.3  Generic outputs 
Select Other for generic outputs. Configuration is as for the Throttle. 

8.10 CAN bus 
Both the YourDyno Ultimate and the YourDyno Standard include built in CAN bus 
support. The Standard needs a license to enable it, while the license is always included 
in the Ultimate. Both CAN input and output are supported, as well as a CAN bus 
analyzer.  
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8.10.1 CAN bus basics 
A CAN bus is a very common communication protocol between different parts of the 
engine and sensor components. Most aftermarket ECUs have CAN bus support, which 
means you can log internal ECU parameters like RPM, pressures, temperatures, ignition 
angle, etc together with the other dyno data and plot them together. Very useful! 

Many off the shelf sensors also have CAN bus support, which means you can easily 
extend the functionality of the dyno. Finally, you can also send channels data out to 
displays, the ECU, external logger or whatever on the CAN bus.  

The data format for CAN messages consists of an CAN ID (address) and the data. The 
data is formatted a certain way, and you need to know that format in order to decode 
the data.  

8.10.2 The CAN bus analyzer 
The CAN bus analyzer is useful to see what is happening on the CAN bus. All data going 
in and out of the YourDyno box is displayed. If no data is seen, try a different baud rate 
or swap CAN+/- (also called CANH/CANL). 

The analyzer will show the CAN ID and 8 bytes of raw data for each ID.  

8.10.3  CAN Inputs 
To convert the data on the CAN bus into data channels, their format needs to be 
defined. There are two ways to do this. 

1. Using a .dbc file, which includes all data definitions you need. Some .dbc files are 
included in the YourDyno installation, and you can also read your own .dbc file. 
Some ECUs can write their CAN configuration as a .dbc file, and in that case you 
can just read it in and click Log data on the channels you are interested in. Don’t 
click on those you are not interested in as it will increase CPU load and clutter 
the system with unused channels.  

2. Define the channels manually 
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Id mask: used to match one or more than CAN IDs. Normally it is FFFFFFFF, then it 
matches only 1 address.  

Channel name: User defined name of the channel 

Start bit: This is the position for the first bit in the data channel. Each CAN Id includes 8 
bytes (64 bits) and can include several data channels. For example, the channel 
Lambda above starts from bit position 32 and is 16 bits long 

Data length: The size of the data channel in bits. This is typically 8 or 16 bits but can be 
anything 

Big Endian: Whether the data is Big endian or Little endian 

Is signed: Whether the data is signed. For example, a signed 8 bit number is -128 to 
127 while an unsigned 8 bit number is 0 to 255 

Offset and Factor: The Channel value = Raw CAN value * Factor – Offset 

Raw CAN value: The data directly read from the CAN bus using the CAN Id, Start bit, 
Length, Endian and Signed setting 

Channel Value: The translated data value 

Unit: User defined unit 

Configure: Use this to translate further between the Raw value and channel value (for 
example for non-linear translations) 

8.10.4 CAN Outputs 
Any channel can be output on the CAN bus. All data are represented as 16 bit numbers.  

 

The columns are similar in function as for CAN inputs.  

8.11  Average calculation 
Sometimes it is useful to compare the average power within an RPM range, rather than 
just the max power. Use this option to set the RPM range of interest and whether all 
channels or just Power/Torque are to be calculated. The results are available in the 



YourDyno Instrument kit 
Software user manual 

YourDyno.com 
Fonneland Engineering AS, 2024 

 

Page | 34 
 

table below the runs and in Results tables. It can also be shown in the splash screen 
after the run.  

 

8.12  Environmental (weather) correction 
8.12.1  About environmental correction 
If it is hot, humid and low pressure one day and the next it is cold, dry and high 
pressure, the exact same engine will show much better performance on the second 
day unless compensated for. The correction formulas all define the “standard” 
environmental conditions and make a correction factor to compensate for the 
difference the actual conditions make relative to the standard.  

To enable power/torque correction calculation based on environmental conditions 
please select the correction of choice. YourDyno supports:  

 SAE J1394-2004 
 DIN 70020 
 ISO 1585-2020 
 EWG 80/1269 
 JIS D1001 
 STD (J607) / STD (J607)+ 
 User defined 

 

8.12.2  Which correction factor to choose 
Some correction factors use standard conditions that are very favorable (= results will 
be higher) and some are unfavorable. The most favorable is the STD+. DIN is also very 
favorable. SAE is on the opposite side.  

The STD correction is very popular in the US, while the DIN or SAE is more popular in 
Europe.  

There is no right or wrong choice but be aware of the differences and compare apples 
to apples. 

8.12.3  Source of data 
You can choose between the YourDyno environmental sensor, use an off the shelf 
sensor (Dracal PTH200) or enter the values manually. The Dracal is mostly used for 
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older YourDyno Standard that had the sensor built into the box, which was not ideal if 
the box was placed in a cabinet. Newer (v5) version of the Standard, and the Ultimate 
have external environmental sensor, so there is no point in using the Dracal.  

 

 
8.13 Unit selection 
You can choose between different units in this section: 
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8.14 Noise filtering 
To modify the Noise filtering settings, adjust the three fields to desired level. 

We strongly advise to use lowest possible settings that allow good results and graph 
smoothing. 

 
Too smooth graphs will obstruct the ability to find faults in engine operation. 
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Note that individual data channels can override the default noise filtering setting. This 
is setup in the Options->Visual settings section. 

8.14.1  RPM spike removal 
Occasional RPM spikes are removed by the RPM spike removal filter.  

 
If you see flat spots in the RPM, try turning off the RPM spike removal by setting it to 0. 
The amount of tooth to tooth jitter in an the RPM signal varies from setup to setup. 

8.15  Raw data logging 
This feature enables raw data logging capability of the YourDyno Software. It can be 
used to troubleshoot and adjust dynamometer settings after a recorded test Run. To 
use this feature please enable checkbox "Enable raw data logging". 
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8.16 Company logo 
You may choose to setup your company name or any other text to be displayed above 
Graph Area. 

This text will also be visible on print-out. 

 

8.17  Define hotkeys 
Use this section to define hotkeys on a keyboard. 
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A wireless keyboard or wireless “clicker” such as the Logitech R400 or a more fancy 
Xencelabs Quick Keys is recommended, and its buttons can be configured with 
hotkeys. 
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8.18  Visual styles 
The line styles of individual channels can be set here. Click on the curve and select the 
style you prefer.  

Comparison is used when several runs are compared in the Live results table. It will 
show shades of red and green depending on which result is better and worse. 

Noise filtering provides an override of the default noise filtering. This is useful for 
example to turn off filtering of some individual channels, for example Brake%. 

 

8.19  Firmware upgrade 
This section allows you to perform Firmware update of the YourDyno controller. 

  

 
Whenever “Update firmware” is shown in the status bar at bottom left, you must 
update the firmware. The firmware update system includes a failsafe mode such that it 
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will revert to the previous firmware if an update was unsuccessful. There is also a 
second failsafe option; a button inside the box that can be pushed to force the unit into 
bootloader mode such that it is ready for firmware download in case a firmware 
upgrade failed.  

8.20  Language 
To change the interface language please select it from the menu list. 

The YourDyno Software will restart automatically. 

 

8.21  Restore and Backup options 

 
All settings in the YourDyno software are stored in an internal configuration file. You 
can “Backup the options to file” and use "Restore options from file" function to load the 
configuration file. 

9 Menu: Plugins 
9.1 Mange plugins... 
This window allows users to add or delete plugins. 
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All plugins are complied .dll files and stored in: C:\ProgramData\YourDynoPlugins 

9.2 Installing new plugin 
Installing official YourDyno plugins are done during installation of YourDyno. Do not 
download .dlls and install manually, since they are version dependent.  

To install 3rd party plugins please press the "Install plugin..." button in "Install new 
plugin" section. Then navigate to folder where your .dll file is saved. Select the file to 
install and press "Open" 

Your Plugin is now installed and ready to use. 

9.3 Removing plugins 
To remove any plugin, the associated .dll file must be manually deleted from the 
C:\ProgramData\YourDynoPlugins folder. Exit the YourDyno software first: 
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9.4 Scan Tool (OBDII plugin) 

 
To use the Scan Tool plugin make sure that the built-in OBD functionality is deactivated 
(see: Menu: Options -> OBD2 setup) 

An ELM327 Bluetooth or USB OBD2 adapter can be used. First install the software if 
any that accompany the adapter. If the ELM327 adapter is Bluetooth based, then 
connect to it first. Verify that you can see the adapter in the Device Manager. They 
appear as COM ports.  

Open YourDyno Software and navigate to Plugins -> Scan Tool. In the Connection tab 
please select which COM Port is in use, select Baud Rate (use 9600) and Connection 
type (OBD2 ELM) and press Connect. It may take up to one minute to connect to car's 
OBD interface. 
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9.4.1 Logging OBD parameters during test run 
1. Please navigate to "Live Data" tab in Scan Tool Plugin and select which channels you 
wan't to record (double-click) 

2. Activate checkbox "Log to gauges" 

3. Press "Start Logging" button. You may now close the Scan Tool plugin window. 

4. In Run window you may now add new gauges with respective OBD channels. 

 
Please note that the data logging from OBD-Adapter will work only with YourDyno 
hardware connected to PC. 
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9.5 Speed and distance 
This plugin is adding new data channels: driving speed and driving distance. This is 
installed by default. 

To use the speed and distance channels setup the roller circumference (i.e. diameter in 
meters * 3.14).  

9.6 More plugin information 
Information on how to create your own plugins can be found here:  
https://yourdyno.com/plugin-system/ 

10 Data Graph/Table area. Data analysis. Test Run list. 
10.1  Graph/Table tabs 
Results are presented in graphs and data tables. Different tabs contain a configurable 
graph view or a table view. Tabs are individually configured and tabs can be added or 
removed or renamed. 
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This creates a new tab with a graph view with Time as the X-axis. There are some 
predefined templates, in this instance Brake Setup Analysis, which will plot relevant 
channels for analyzing the brake control performance. Other channels can be added 
and removed as needed. 

There is no limit to the number of tabs you can define, and their setups are stored. 

10.2  Graph views 
The Graph area can be divided into maximum three sections and channels can be 
plotted in any graph.  

To add and remove channels to the graph areas, press the ‘v’ button or right-click and 
select “Select visible graphs”. To split the graph area, add new channels into view.: 
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After adding additional channels like Lambda the Graph area is split horizontally: 

 

 

 
To relocate the channels between graphs use "Drag-and-Drop" technique. Left mouse 
button on the label and drag it over to another graph/axis. 

You can adjust the size and position of the horizontal and vertical dividers by dragging 
them with mouse cursor: 
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10.2.1  Manipulating the graph area. Context menu. 
LMB - LEFT mouse button 
MMB - MIDDLE mouse button 
RMB - RIGHT mouse button 

1.  
Quick reference guide: 
1. To move/drag the graph use MMB. 

2. Press and hold LMB to drag an Zoom-Area rectangle. 
3. Press RMB to open context menu. 
4. Use mouse wheel to Zoom In and Out. 

10.2.2  Context menu 
Un-Zoom / Undo All Zoom/Pan - use this function to reposition the graph back to 
normal view. 
Set Scale to Default - changes the channel scale back to standard value 
Synchronize Y1 and Y2 axes - synchronizes Y-axis for all channels in the selected 
graph 
Increase / Decrease line thickness - use this function to change graph thickness. The 
changes is applied only in the section where the RMB menu was activated 
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Edit graph - Use Ctrl key and LMB to select which graph area you want to cut. This 
change cannot be undone. The software will lineally interpolate the graph if you 
remove a center portion of it. 

10.2.3  Results vs RPM 
This is a default graph view, and most typical use scenario for Power Test runs. In this 
view all channels are plotted against the Engine RPM channel. Use this view to print 
dyno sheets for customers. 

 

10.2.4  Results vs Time 
This is another default view. All channels in every Run are recorded in Time function, 
and this view shows the data as it was recorded.  
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10.2.5  Other X-axis 
In the <New tab> definition, any axis can be used as the X-axis. All recorded data will be 
plotted against that selected channel. This view is very useful to find best possible 
calibration of the tuned engine (for example when using Engine Torque as function, or 
Torque vs Ignition angle): 

 

10.3  Results table views 
Data Tables allow users to analyze the recorded data in a spread-sheet format: 
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Some tips for result tables: 

 The context menu (right click) lets you change the master channel, set the 
interval (a row for every 200 RPM in the example above), Select visible data. You 
can also copy the data or open it in Excel 

 The columns can be sorted by drag/drop 
 The highest power and torque figures are shown in green 
 You can have multiple tabs with Results tables with different setup and channels 

10.4  Test Run List 
Below the Graph Area you'll find list of Runs. 
You may change the Name and comments by clicking and editing the respective field. 
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Different columns shown/hidden by right-clicking:  

 

Rows can be sorted by clicking on the header. 

11 Run window 
11.1  Overview 
The Run window consist - like main window - of three main areas: 

1. Test name and comments section 
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Use these fields to set Name for the Run and add Comments if necessary. 

On the right side of the Comments field current you will also see the current 
"Horsepower correction factor" and type of Session (either with or without Friction 
Losses / Retardation data measurement) 
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2. Gauges 
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3. Controls: 

 

11.2  Configuring Gauges 
11.2.1  Adding new gauges 
The gauges can be arranged to suit any style of work. 
You can add any recorded channel as gauge by pressing the "V" key on Keyboard or 
"Gauge on/off" button in the Controls area: 

 

A new window will pop-up with list of available channel. Gauges can be auto arranged 
or manually arranged, defined by using the "Auto arrange gauges" checkbox. 
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11.2.2  Types of gauges 
Analog, Digital, Bar and Graph gauges are supported. Gauges can be configured with 
different colors, alarms, tick marks and ranges.  

11.2.2.1 Analog 
This is a typical "tacho" style gauge with definable Green, Yellow and Red area. 
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Use the "Gauge setup" function in context menu to setup the gauge: 

 
11.2.2.2 Digital 
This is a standard "number" style gauge with a horizontal bar below the value showing 
the range of the gauge. 
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The colors and other parameters for the horizontal bar are defined with the "Gauge 
setup" function as well. 

11.2.2.3 Live graph 
This type of gauge is a live-time graph with automatically adjusted X-axis. They are also 
setup by right click and “Gauge setup”.  
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Graph type gauges can use any channel as X-axis. This can be especially useful in 
steady state tuning, where you can get an instant Torque vs Lambda view or Torque vs 
Ignition angle view for example (assuming of course you have an Ignition angle channel 
from for example a CAN bus channel).  

 

 

11.2.2.4 Bar gauge 
Bar gauges uses a horizontal or vertical bar to indicate the value. 
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Ranges, colors, indicators, alarms etc are set as for other gauges.  

11.2.2.5 Group gauges 
Gauges can be grouped. This is useful if you have for example 8 thermocouples or 2 
brakes or other channels that shall be compared during the run.  
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The example shows 6 temperatures sensors in one group gauge.  

To create/edit a group gauge click Create group gauge or Edit group gauge in the 
window where you select channels (‘v’ button or Gauge on/off button).  

 

Group gauges are turned on and off and configured as other gauges.  
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11.2.3  Example on one of possible gauges setup 

 

 

11.3  Gear ratio setup 
When the gear ratio is known, select Set gear ratio manually and enter it in the text 
box. For engine dyno directly connected to the brake, the gear ratio is 1.  

 

If the gear ratio is not known, it can be measured in a variety of ways.  
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The Engine RPM calculation in YourDyno system is based on the RPM signal from the 
brake/roller RPM sensor(s). There are many reasons why the actual Engine RPM (for 
example from OBD2 interface) cannot be used to correctly control the dynamometer. 
Mainly they are too slow. Since all roller dynamometers measure torque at wheels, it is 
important that the Gear ratio is correctly set. Otherwise, the Engine Torque reading will 
not be correct. 

11.3.1.1 Tacho 
This is the fastest but also least accurate way of determining the Gear ratio. 

 

1. Select Tacho RPM setpoint. It is recommended to use middle of the Tachometer 
range somewhere that is easy to keep the engine revving at constant revs. 

2. Enter the vehicle and accelerate the car to reach the set RPM 
3. Make sure you are on the gear you wish to use later for the test Run. Usually, it's 

4th or 5th gear 
4. Try to hold the engine RPM at setpoint RPM value as precise as possible 
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5. When the RPM reading at vehicle tachometer is stabilized at setpoint value press 
"Lock gear ratio" button. 

The YourDyno Software now "knows" what is the total Gear ratio between engine and 
rollers. 

 
Please note that whenever you'll change gear the Gear ratio will be off and you need to 
repeat the procedure. 

11.3.1.2 Using other channels as the direct Engine RPM source 
Other channels, for example the Engine RPM Pickup channel (requires an inductive 
pickup over a coil wire) can be used as the direct engine RPM source. In this case, 
choose the correct channel, hold the RPM steady and click Lock gear ratio. Any RPM 
can be held, as long as it is stable.  

11.3.1.3 Variable gear ratio 
In case the gear ratio changes during the run, due to an auto gearbox or similar, the 
Re-calculate results from variable gear ratio option can be used.  

 

This requires a direct engine RPM measurement. It will recalculate the results after the 
run is complete, to produce Results vs Engine RPM  

 

11.4  Brake Control Setup. PID settings 
YourDyno supports a number of different brake control modes, suitable for almost any 
scenario and setup. 

In this section you can setup the properties for the different Brake Control / Test 
Modes. To open the Brake Control Setup please the "Brake setup" button in Run 
window: 

 

11.4.1  Basic setup 
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11.4.1.1 Ramp up brake 
Use “Ramp up brake” to ensure the engine is nicely loaded by the time it reaches the 
start RPM. Too low “Ramp up brake” and the RPM will overshoot the start RPM and the 
regulator will bring it down over some seconds. Too low “Ramp up brake” and the RPM 
will not reach the start RPM because of too much brake. Experiment a bit to get this 
roughly right for a smooth start. 

Typically we want the brake to start ramping up much earlier than the start RPM so the 
brake has time to build up brake force. 1000 RPM is used in the example above. 

Move advanced ramp up curves can be defined using the Advanced button.   

11.4.1.2 Slow down after run 
Use this option to turn on the brake after the run is complete to quickly stop the 
rotation. 
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11.5  PID Control loop setup 
Several brake modes use a PID controller to regulate the brake force: 

 Manual RPM control 
 RPM Curve 
 Power sweep 
 Sequencer 

A PID controller is a common regulator which uses 3 parameters; Kp, Ki and Kd. It is 
recommended to read up on them on google/youtube to get some familiarity with the 
parameters.  

 

Kp = 0.5, Ki = 0.5, Kd = 0.05 is a good starting point for many setups.  

11.6  Brake Modes 
11.6.1  Manual brake control 
Two types of Manual brake control exist; Control Target RPM and Control brake 
directly.  

In the "Control Target RPM" mode the YourDyno Software will hold the set target 
engine RPM regardless of engine load (throttle opening). Adjust the RPM increment / 
decrements step using the corresponding field. 

 
How well the YourDyno controller will hold the target RPM depends on the PID settings 
used. Adjust the PID parameters if needed. 

In the Control Brake % directly mode, the brake is fully manually controlled with the 
mouse or hotkeys.  
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11.6.2  RPM Curve 
Two types of RPM curves exist: Control RPM vs Time and Control Brake vs RPM.   

11.6.2.1 Control RPM vs Time 
In the Control RPM vs Time mode the YourDyno Software follows predefined Engine 
RPM target curve. 

You may add multiple RPM targets to create a test profile. 

Use mouse cursor to drag the RPM target points on the diagram. 
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Press "Edit ramp" button to open an RPM setpoint table and edit it manually. 

Use "Load ramp" and "Save ramp" buttons to save and load RPM setpoint profiles from 
your hard drive. 

11.6.2.2 Control Brake vs RPM 
In this mode the brake is directly controlled by the RPM. This mode works best for 
dynos with high inertia, and can be particular useful when testing cars with an abrupt 
torque curve. The Brake force is simply defined by the RPM of the car, so the torque 
rise can be anticipated.  

11.6.3  Power Sweep 
The Power Sweep Test Mode is the typical acceleration test performed to measure the 
Engine Power and Torque and draw the known "normal" dyno graph. In this Test Mode 
the acceleration rate (Sweep rate) defines how fast the Engine RPM will increase. 

In the "Start condition" section you can define the starting Engine RPM and wait time 
(preload time). The preload time is used to allow build-up of induction pressure in 
engines equipped with forced induction (super-charged / turbo-charged engines) 
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In the "Define sweep" section select the desired Sweep rate in RPM per second and 
Stop RPM. 

 
Set the "Stop sweep at" RPM approximately 250-500 RPM below the vehicles RPM-
limiter. 

 

11.6.4  Load Control 
This advanced Test Mode is especially useful with Water Brakes or when the tested 
engine has a very fast torque increase which can cause oscillations when using 
standard PID regulator. 

The regulator basically lets the engine accelerate in a more natural way. This means the 
regulator lets it accelerate faster where it is strong and slower where it is weak. A PID 
regulator on the other hand always tries to make the RPM follow the set target RPM 
exactly, which more easily causes oscillations.  
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The main parameters here are Gain and Derivative factor. 

The Gain is basically how aggressive the regulator is. Higher number means a more 
straight line acceleration (but also higher chance of oscillations). Derivative factor can 
be thought of as a Acceleration factor. It will give more brake if the RPM suddenly 
accelerates.  

A good starting point is Gain 15 and Derivative factor 0.03.  

Under "Advanced" button you can change the "Gain factor" and "Sweep rate factor" 
over the RPM range if needed. 

11.6.5  Brake sweep 
This test mode was designed especially for hydraulic brakes. In this Test Mode the 
brake output is gradually increased or decreased without the use of PID control. This 
means that the target sweep rate and actual engine RPM may vary as the Brake Sweep 
mode will not try to stabilize the engine RPM - instead it will only gradually increase 
brake output from the "Start brake" value. 

 
The benefit of this Test Mode is that because no PID control is in use the system will 
not generate any oscillations. 

 

Note that most hydraulic dynos work best from high to low RPM. To enable this, set the 
Target sweep rate to a negative number, for example -500 RPM per second. 

11.7  Auto start stop 
11.7.1  Automatic recording of test Run 
This function allows automatic recording of test Run. Use the corresponding tab in 
"Brake setup" window to adjust the "(Re)Start run at RPM:" value. 
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When Retardation data (Friction losses) measurement is ON the recording of the test 
Run will stop only after the engine RPM has dropped back to Starting RPM value. 

 

 

Auto detect early stop will stop data recording even if the end RPM was not reached by 
looking at the torque, which drops when the throttle is closed.  

11.8  Brake control update frequency 
The brake can be controlled (adjusted). Normally 20 times per second is 
recommended.  

11.9  MOI wizard 
The automatic MOI (moment of inertia) wizard can be used to determine the complete 
system inertia (dynamometer + vehicle). 
The MOI setting is base for all result evaluation thus it is recommended for all users to 
perform the automatic MOI test for all vehicles prior to actual power test. This test is 
performed using two coast-down phases: first un-braked and second braked. From the 
difference in de-acceleration of the vehicle between these two tests the software will 
calculate the system MOI. 

Please note that this calculated MOI takes following losses into account: 

 Friction losses in drive-train 
 Friction losses between roller and tire 
 Friction losses in dynamometer 
As with any other roller-dynamometer there are still some losses which cannot be 
measured during such procedure (for example hysteresis of elastic components and 
power losses in drivetrain). 
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11.9.1  Automatic MOI test procedure 
1. In the Run window please open the "MOI setup" wizard. 

 

2. Click Setup and ensure the max speed can be safely reached  
3. Accelerate to perform two test runs. It is not necessary to perform these tests 

under WOT conditions  
4. At the end of second test the wizard will show you determined MOI value. You can 

now decide if you want to use this value for actual power measurements. 
 
11.9.1.1 MOI wizard settings 
Since the automatic MOI test takes place during coast down phase (clutch pressed or 
automatic gearbox in N) you can use the Advanced Settings to include Engine Inertia in 
the calculation. 

If you are not sure what value to use, please leave the default setting. 

 

Set the Retardation brake % such that the second run is significantly slower than the 
first, but not so slow that there is very little date. At least ~5 seconds of retardation 
data is needed. Some experimentation is needed here.  
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12 Setup examples 
12.1  Water brake example 
12.1.1  Load cell 
Configure 1 load cell, turn on inertia effects and set MOI depending on the engine + 
water brake (around 0.6 for a V8 for example).   

 

12.1.2  Do NOT turn on retardation data measurement 
Retardation data measurement turns off the brake when hitting the end RPM, which is 
NOT wanted for engine dynos. So make sure this option is off.  
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12.1.3  RPM 
Use RPM1 and configure it like this:  

 

12.1.4  Brake output 
Use Out1/Out2 and configure it like this (or other valve type):  

 

12.1.5  Brake control mode 
Load Control is recommended. Good starting point:  
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12.2  Inertia dyno example 
12.2.1  Basic 
Turn on Inertia mode  

  

Brake dyno mode can also be used if the load cell reads 0. This is useful for setups that 
have a non-measured brake that is only used to slow down rotation after the run.  

12.2.2  RPM sensor 
Set RPM1 function to be Load cell 1 RPM. The selection here is a bit illogical since there 
is no load cell, but this is the correct selection. 
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12.2.3  Run window 
No brake mode is available for inertia dynos, but auto start/stop can be set like for 
other dynos.  

12.3  2WD chassis dyno example 
12.3.1  Load cell 
Configure 1 load cell, turn on inertia effects. You need to measure the MOI either 
manually or by using the MOI wizard or you can try to calculate it.  

 

12.3.2 RPM 
Use RPM1 and configure it like this:  

 

12.3.3  Brake output 
Use Out1 and configure it like this (or other output type):  
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12.3.4  Brake control mode 
Power sweep is recommended for normal sweeps.  

12.4  4WD chassis and 2WD hub example 
12.4.1  Using the right inputs and outputs 
The RPM, Load cell and Out channels work together. RPM1, Load Cell 1 and Out1 are 
used for the same brake. You cannot mix and match the channels. Correct setup  
below: 

 

12.4.2  Load cells 
Configure 2 load cells and configure the MOI 
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12.4.3  RPM 

 

12.4.4  Brake setup 

 

12.4.5 Brake control mode 
Power sweep is recommended for normal sweeps. 

12.5  4WD hub example 
The setup requires a YourDyno Ultimate or 2 YourDyno Standards. The setup is 
basically the same a 2WD hub dyno, only it uses 4 load cells, 4 RPM sensors and 4 
brake outputs.  

13  Tips and tricks 
13.1  Finding the right Moment of Inertia (MOI) 
The MOI impacts the power and torque readings like this:  

Torque = (Load cell torque + Acceleration * MOI) / Gear ratio 

Obviously for an inertia dyno, the Load Cell component is 0. 

When the MOI is high, a significant portion of the power/torque comes from 
accelerating the heavy roller/brake, so it is important to get the MOI number right. 

In addition to the MOI Wizard described in chapter MOI wizard11.9 there are a number 
of ways to find the MOI manually, but each one with its own pitfalls.  

13.1.1  Double ramp 
This is a classic way of measuring the MOI. The procedure is:  
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 Define an RPM curve like this: 

 
 Hold full power both going up and down 
 When done, compare the results in the Results vs RPM. If results are higher 

going up then MOI is too high and vice versa 
 Adjust the MOI and read back the raw log file to re-run the same run until results 

overlap as much as possible 

 

Pitfalls: 

The procedure only works if the engine performs the same going up and going down. 
There can be heat soak (=lower power going down), air cleanliness difference, turbo 
pressure difference, etc. 

13.1.2  Steady state + Ramp 
The procedure is to do a steady state test at a certain RPM and do a sweep. The sweep 
and the steady state run shall have the same power/torque at the steady state RPM, if 
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not adjust the MOI and re-run the sweep. The steady state does not need to be rerun, 
since MOI does not impact steady state power.  

Pitfalls: Same as for double ramp 

13.1.3  Test in different gears 
This is potentially a good way to measure the MOI, and the only semi-simple way for an 
inertia dyno. You define a Power sweep with a set RPM/s, which will be the same for 
both runs. This way, if the engine behaves somewhat differently in fast and slow 
sweeps, ramping up and ramping down, etc, then that does not come into play (since 
the engine will ramp the same). 

Procedure:  

 Define a power sweep from low to high RPM 
 Set gear ratio in the highest gear allowable 
 Do Run1 with this gear 
 Write down the gear ratio and set gear ratio for the a lower gear 
 Do Run2 with this gear 
 Compare the runs and redo with different MOI until they match. Note that you 

need to manually set the gear ratios for each run 

Pitfall: 

The engine also has some MOI and its impact is slightly different between the runs 
because the gear ratio is different. This can be ignored if the MOI is sufficiently large. 

13.2  Finding the best brake control settings 
Finding the best PID numbers for the brake regulator takes some practice. Same for 
Gain/Derivative factors for Load Control.  

13.2.1  Looking under the hood of the regulator 
First step is to create a Brake setup analysis tab: 
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Now a new tab is created where the Engine RPM, Brake % and components of the 
PID/Load control algorithm are plotted. You can add channels to the graphs of course. 

Example: This is a Toyota Supra drift car with very abrupt torque band: 

 

On the top graph we see the Engine RPM vs Target RPM in blue. The Brake is in red. As 
we can see, the Engine RPM overshoots its target before it is pulled down to the target. 
This happens as the engine hits the torque band.  

Overshoot 
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On the bottom graph we see the components of the PID regulator. The Brake% = Kp + 
Ki + Kd.  

The problem is that the regulator is too “loose”. It lets the engine overrun too much. 
That means we need to increase some parameters to make the brake control harder. 

None of the parameters Kp, Ki or Kd oscillate, so each one is a potential candidate to 
increase.  

 Kd reacts to acceleration and is the fastest to respond to deviations from the 
target. So, trying a Kd increase first is a good approach. Kd is very responsive so 
be careful with the increases (too much = oscillations) 

 Kp is next to respond, it responds to the difference between the target and the 
actual RPM. So increasing Kp will also help.  

 Ki responds to the accumulated difference between target and actual RPM over 
time, so it is slower to respond. It will likely not help in this case. We also see the 
steady state error is small once we come over the torque band, which is another 
sign that the Ki is ok.  

In general, the parameters should not oscillate (much). An oscillation is normally 
caused by the parameter being too high.  

13.2.2  Analyzing load control 
When analyzing the Load Control brake mode, Kp Factor = Gain and Kd factor = 
Derivative Facor. There is no Ki. Otherwise the procedure is the same as for PID tuning. 

13.2.3  Turning off noise filtering on brake channels 
It is often easier to see what is going on with the brake performance with the noise 
filtering set to 0 for those channels. Do it for the Brake1, and for Kp, Ki and Kd.  
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13.3  Drive modes when testing a 2WD car on a 4WD dyno 
13.3.1  Non-linked dyno 
For a non-linked dyno, the non-driven wheels will not spin, but they may move a little, 
causing the RPM sensor to sense some movement. It is recommended to put the RPM 
sensor on the non-driven wheels to Not used while testing a 2WD car on a 4WD non-
linked dyno. 

In the example below, the driven wheels are on RPM2. 
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13.3.2  Linked dyno 
For linked 4WD dynos, the brake on the non-driven wheels will also be applied during a 
run, unless that brake output is set to Not used. Therefore, set the brake output to Not 
used. In the example below, the wheels on RPM1/Out1 are not driven (but still 
spinning). 

 

Note that setting the RPM sensor to Not used would also turn off the brake to those 
wheels, but power/torque would be wrong, because the acceleration and inertia (MOI) 
of that RPM sensor will be ignored. 

13.4  Non-linked 4WD dyno concerns 
Many vehicles have a complicated 4WD system, where one wheel pair (usually the 
front) are the primary driven wheels. Only when the vehicle senses what it believes is 
spin will power also be transferred to the other wheel pair.  

In this case, turn on the “Use advanced gear ratio setup” in Gear ratio->Advanced. 

 

With this option on, the gear ratio will be calculated from the primary driven wheels.  

With a linked 4WD dyno, this option does not need to be used. 
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13.5  Automatic RPM Step test 
You can use the RPM Curve mode to perform semi-automatic RPM Step tests where 
the YourDyno Software will increase the Engine RPM target after specified time.  

 

 

 

14 Support 
For support contact YourDyno.com at https://yourdyno.com/about-us/ 

To review runs for potential issues we need: 

 The csv file of the run(s) (File->Save as csv) 
 The raw log file of the same run(s) 
 The saved options file (Options->Backup options to file) 

Please don’t send many runs! Only send enough to quickly can see the problem or 
question you might have. 1 or 2 runs is enough in 99% of the cases.  


